Rational Directory Server

Administration Guide
Before using this information, be sure to read the general information under Appendix, “Notices” on page 25.

This edition applies to VERSION 5.0, IBM Rational Directory Server and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright IBM Corporation 2006, 2010

US Government Users Restricted Rights—Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
**Table of contents**

**About this manual**  
Contacting IBM Rational Software Support. .............................................. 2  
Prerequisites .......................................................................................... 2  
Submitting problems . ......................................................................... 2  
Conventions used in this guide .............................................................. 5  

**Introduction**  
RDS architecture. ................................................................. 7  
Who should use this guide .............................................................. 8  
Frequently Asked Questions ............................................................ 8  

**Directory Server Administration**  
Starting the directory server ......................................................... 11  
Stopping the directory server .......................................................... 12  
Backing up the Rational Directory Server ...................................... 12  
Restoring the Directory Server ....................................................... 14  
Authenticating the OS through PAM ............................................. 15  
Changing the RDS operation mode ................................................. 16  
Trusted OS authentication settings ............................................... 18  
Settings for assigning license feature. .............................................. 19  
   Standalone mode. .................................................................. 19  
   Corporate mode .................................................................. 19  
Enabling Secure Sockets Layer (SSL) security ............................. 20  
   Exporting the certificate from the Active Directory server ........ 20  
   Importing the certificate to the IBM Rational products .......... 20  

**Troubleshooting RDS**  

**Appendix A: Notices**  
Trademarks ...................................................................................... 28
1

About this manual

This manual guides you through the IBM® Rational® Directory Server (RDS) administration. This document contains step-by-step instructions for administering the RDS.

RDS documentation

This section provides the information on the related documents available for RDS. The following RDS documents are available on the Product Support Web site, http://www.ibm.com/software/rational/support/.

<table>
<thead>
<tr>
<th>Document name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Rational Directory Server Installation Guide</td>
<td>Provides information on how to install the RDS.</td>
</tr>
<tr>
<td>IBM Rational Directory Server Product Manual</td>
<td>Provides detailed information on RDS features supported in this release.</td>
</tr>
</tbody>
</table>
Contacting IBM Rational Software Support

If the self-help resources have not provided a resolution to your problem, you can contact IBM® Rational® Software Support for assistance in resolving product issues.

Note If you are a heritage Telelogic customer, a single reference site for all support resources is located at http://www.ibm.com/software/rational/support/telelogic/

Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active Passport Advantage® software maintenance agreement. Passport Advantage is the IBM comprehensive software licensing and software maintenance (product upgrades and technical support) offering. You can enroll online in Passport Advantage from http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

- To learn more about Passport Advantage, visit the Passport Advantage FAQs at http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html.
- For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you must additionally:

- Be a registered user on the IBM Rational Software Support Web site. For details about registering, go to http://www.ibm.com/software/support/.
- Be listed as an authorized caller in the service request tool.

Submitting problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you are asked to supply a severity level. Therefore, you need to understand and assess the business impact of the problem that you are reporting.
Submitting problems

Use the following table to determine the severity level.

<table>
<thead>
<tr>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The problem has a <em>critical</em> business impact: You are unable to use the program, resulting in a critical impact on operations. This condition requires an immediate solution.</td>
</tr>
<tr>
<td>2</td>
<td>This problem has a <em>significant</em> business impact: The program is usable, but it is severely limited.</td>
</tr>
<tr>
<td>3</td>
<td>The problem has <em>some</em> business impact: The program is usable, but less significant features (not critical to operations) are unavailable.</td>
</tr>
<tr>
<td>4</td>
<td>The problem has <em>minimal</em> business impact: The problem causes little impact on operations or a reasonable circumvention to the problem was implemented.</td>
</tr>
</tbody>
</table>

2. Describe your problem and gather background information. When describing a problem to IBM, be as specific as possible. Include all relevant background information so that IBM Rational Software Support specialists can help you solve the problem efficiently. To save time, know the answers to these questions:

- What software versions were you running when the problem occurred?
  
  To determine the exact product name and version, use the option applicable to you:
  
  - Start the IBM Installation Manager and select **File > View Installed Packages**. Expand a package group and select a package to see the package name and version number.
  - Start your product, and click **Help > About** to see the offering name and version number.

- What is your operating system and version number (including any service packs or patches)?
- Do you have logs, traces, and messages that are related to the problem symptoms?
- Can you recreate the problem? If so, what steps do you perform to recreate the problem?
Chapter 1: About this manual

- Did you make any changes to the system? For example, did you make changes to the hardware, operating system, networking software, or other system components?
- Are you currently using a workaround for the problem? If so, be prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your problem to IBM Rational Software Support in the following ways:

- **Online**: Go to the IBM Rational Software Support Web site at https://www.ibm.com/software/rational/support/ and in the Rational support task navigator, click **Open Service Request**. Select the electronic problem reporting tool, and open a Problem Management Record (PMR), describing the problem accurately in your own words.
  
  For more information about opening a service request, go to http://www.ibm.com/software/support/help.html
  
  You can also open an online service request using the IBM Support Assistant. For more information, go to http://www.ibm.com/software/support/isa/faq.html.

- **By phone**: For the phone number to call in your country or region, go to the IBM directory of worldwide contacts at http://www.ibm.com/planetwide/ and click the name of your country or geographic region.

- **Through your IBM Representative**: If you cannot access IBM Rational Software Support online or by phone, contact your IBM Representative. If necessary, your IBM Representative can open a service request for you. You can find complete contact information for each country at http://www.ibm.com/planetwide/.
### Conventions used in this guide

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Italic</em></td>
<td>Used for book titles and terminology.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Used for items that you can select and menu paths, also used for emphasis.</td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td>Used for commands, file names, and directory paths. Represents command syntax to be entered verbatim. Signifies computer output that displays on-screen.</td>
</tr>
<tr>
<td><strong>Courier Italic</strong></td>
<td>Represents values in a command string that you supply. For example, (drive:\username\commands).</td>
</tr>
</tbody>
</table>
Introduction

The RDS is a single enterprise directory solution designed for user authentication and administration for IBM® Rational® Solutions for Enterprise Lifecycle Management tools. RDS allows the users to log on using the same credentials across IBM® Rational® Solutions for Enterprise Lifecycle Management tools for which they have authorized access.

RDS 5.0 supports a wide range of platforms. For more information about the platform support, see the IBM Rational Directory Server Installation Guide.

RDS architecture

The following diagram shows the RDS architecture.
Who should use this guide

This guide is intended for the RDS administrator. The administrator is responsible for the day-to-day operations of the server such as how to run the RDS backup programs and how to recover the directory manager password in case of password loss.


Frequently Asked Questions

1. Which are the external LDAP servers supported by RDS?

2. What is the schema required by RDS in the external corporate server?
   - The user information are extracted from the corporate servers based on the person/inetOrgPerson schema class and the primary attributes cn, sn, email, uid, givenname, telephoneNumber, mail, facsimileTelephoneNumber, description, postalAddress, and sAMAccountName.
   - The group information are extracted based on the group/groupOfUniqueNames schema class and the attributes member/uniqueMember, description.

3. Do we need an Administrator privileges to create a partition?
   - You need a corporate LDAP server user with a Read access to the search bases specified in the partition.

4. I cannot use RDA on Solaris to create a partition with SSL enabled?
   - This is a known limitation. You need to install RDA on Windows as a workaround.

5. Why DOORS do not show up a user after changing the name of the user from one ou to another in the corporate LDAP?
   - If the name of a user (firstname, lastname, cn etc.) is changed keeping the same UID, or if a user is moved from one OU to another in the corporate LDAP?
LDAP, DOORS may not show up the user. The reason is, the RDS has already created an extended user object with the uid as the user logon name (based on the logon attribute selected in the corporate partition) and tds:corporateDn as the corporate DN of the user. If the corporate DN of the user changes in the corporate LDAP server, the RDS will try to recreate the extended user object with the same user logon name (which is not changed in corporate LDAP) and would fail, as the user object with the same logon name already exists in the corporate LDAP. Hence, the particular user would not be shown in DOORS.

To solve this issue, it is recommended to modify the required attributes of the extended user object in RDS. Deleting the extended user object also solves the issue but it may delete the DOORS specific values for that user object, which may lead to information loss.

6. **Is RDS supported on VMWare?**

Currently, the RDS is not supported on a virtual environment.

7. **How do you change the Webserver port from 8080 to any other values for IBM Rational Directory Administration (RDA)?**

To change the default port number:

a. Edit the following lines in the Server.xml file located under

```text
<RDS_HOME/RDA_HOME>/WebAccessServer/apache-tomcat-6.0.16 (-6.0.24 for 5.1.0.1 and 5.1.0.2)/conf folder:
Connector port="8090" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />
```

b. Restart the RDA for the changes to take effect.

**Note** The new port number is changed to 8090 in the above example.
This chapter describes some of the utilities used for the directory server administration on Windows.


### Starting the directory server

Typically, RDS starts automatically after the installation. If the server does not start automatically, start the server manually. To start the server manually, from the command line, use the following commands:

**In Windows**

```
<RDS_Home>/IBM/Rational/RDS_5.0/RDSUtility/
Start_RDS_Server.bat
```

For example:

```
C:\Program Files\IBM\Rational\RDS_5.0\RDSUtility\
Start_RDS_Server.bat
```

You can also double-click the `Start_RDS_Server.bat` from within the installation location to start the server.

**Note**  The RDS is setup as a manual Windows service.

**In UNIX:**

**On Solaris**

```
$ cd <RDS_Home>/RDSUtility
$ ./star_rds_server.sh
```

**Or**

```
$ ./ibmslapd -I tdsadmin -n
```
Chapter 3: Directory Server Administration

On Linux

$ cd <RDS_Home>/RDSUtility
$ ./start_rds_server.sh

Or

$ ./ibmslapd -I tdsadmin -n

Stopping the directory server

From the command line, use the following command to stop the directory server.

<RDS_Home>/IBM/Rational/RDS_5.0/RDSUtility/
Stop_RDS_Server.bat

Windows example:
C:\Program Files\IBM\Rational\RDS_5.0\RDSUtility\Stop_RDS_Server.bat

UNIX example:

On Solaris

$ cd <RDS_Home>/RDSUtility
$ ./stop_rds_server.sh

On Linux

$ cd <RDS_Home>/RDSUtility
$ ./stop_rds_server.sh

Backing up the Rational Directory Server

Backing up the RDS allows you to save a snapshot of the contents should the data be lost or become corrupt. The RDS backup essentially means the backing up of the IBM Tivoli Directory Server 6.2. The backup can be done on Windows, Solaris, and Linux platforms.

When these backup procedures are followed, the system automatically stores a copy of the server files on the same host. For greater security, copy and store these files on a different machine or file system.
Backing up the data

When you back up the server, all contents of the directory are saved in a backup location. This section tells you how to use the idsdbbackup command to back up the directory.

To back up your directory, do the following:

1. Stop the RDS server.

2. Change directory to the following path.
   
   ```
   cd <RDS_Home>/IBM/ldap/V6.2/sbin (Windows)
   $ cd /opt/IBM/ldap/V6.2/sbin (Unix)
   ```

3. Set the permission for the backup folder using the following command.
   
   ```
   $ chown tdsadmin:idsldap /var/backup
   ```

4. Backup the server using the following command.
   
   ```
   dbback -I instance_name backup directory path
   ```
   
   Example:
   
   ```
   $ dbback -I tdsadmin /var/backup
   ```

5. It prompts for the option. Type 1 to continue or 2 to exit.

6. Start the RDS server.

**Note** Post Tivoli/DB2 installation on Unix, creation of tdsadmin user should be accompanied by setting the user home directory to be the install directory (/ appended with instance). For more information on creating the user see, *IBM Rational Directory Server Installation Guide*. 
Restoring the Directory Server

Use the `restore` command to restore the server. Shut the server down before running this script.

To restore your directory, do the following:

1. Stop the RDS server.
2. Restore the backup using the following command:
   ```
   $ dbrestore -I instance_name backup directory path
   Example:
   $ dbrestore -I tdsadmin /var/backup
   ```
3. Start the RDS server.

# Authenticating the OS through PAM

The RDS uses Pluggable Authentication Modules (PAM) to authenticate users on Solaris, and LINUX systems. To allow RDS to authenticate the users, the PAM configuration must be updated to specify the authentication methods to use for the `osauth` service, unless a reasonable default already exists.

Refer to the following tables for updating the PAM configuration.

1. On Solaris 10, the following are the example additions to `/etc/pam.conf` file:

<table>
<thead>
<tr>
<th><code>osauth</code></th>
<th><code>auth</code></th>
<th><code>sufficient</code></th>
<th><code>/pam_unix_auth.so.1</code></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>osauth</code></td>
<td><code>auth</code></td>
<td><code>requisite</code></td>
<td><code>/pam_authtok_get.so.1</code></td>
</tr>
<tr>
<td><code>osauth</code></td>
<td><code>auth</code></td>
<td><code>required</code></td>
<td><code>/pam_unix_auth.so.1</code></td>
</tr>
<tr>
<td><code>osauth</code></td>
<td><code>account</code></td>
<td><code>required</code></td>
<td><code>/pam_unix_account.so.1</code></td>
</tr>
</tbody>
</table>

   **Note** On Solaris, if the server is running with non-root privileges, ensure that server process can read the `/etc/shadow` file.

2. On Red Hat Linux®, the following are the example additions to the `/etc/pam.d/osauth` file:

<table>
<thead>
<tr>
<th><code>auth</code></th>
<th><code>sufficient</code></th>
<th><code>/pam_unix.so</code></th>
<th><code>likeauth</code></th>
<th><code>nulllok</code></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>auth</code></td>
<td><code>required</code></td>
<td><code>/pamdeny.so</code></td>
<td><code>-</code></td>
<td><code>-</code></td>
</tr>
<tr>
<td><code>account</code></td>
<td><code>required</code></td>
<td><code>/pam_unix.so</code></td>
<td><code>-</code></td>
<td><code>-</code></td>
</tr>
</tbody>
</table>

3. On SUSE® Linux, the following are the example additions to the `/etc/pam.d/cmsynergy` file:

<table>
<thead>
<tr>
<th><code>auth</code></th>
<th><code>sufficient</code></th>
<th><code>/pam_unix.so</code></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>auth</code></td>
<td><code>required</code></td>
<td><code>/pamdeny.so</code></td>
</tr>
<tr>
<td><code>account</code></td>
<td><code>required</code></td>
<td><code>/pam_unix.so</code></td>
</tr>
</tbody>
</table>

   **Note** If the `osauth` PAM service is not defined, the default definitions are used. The default definitions are configured with the service name `other`.

   On UNIX systems, the Administrator will need to provide read access to the `/etc/shadow` file to `tdsadmin` user (/created during RDS installation) for OS Authentication mode to function.

   For example, `$>chmod 444 /etc/shadow`
4. On AIX®, the Base Operating System performs the authentication.

**Changing the RDS operation mode**

The RDS provides the `rdsconfig` utility to change the RDS operation mode from the command line. The RDS uses the operation mode to perform the authentication. For example, if the operation mode is changed to OS authentication mode, the authentication is done based on the domain name on Windows.

You can change the operation mode by doing the following:

On Windows:
1. On the command line, change the directory path to the following:
   
   `<RDS_Install>\RDS_5.0\IBM\IBM\Rational\RDS_5.0\RDSUtility`

2. Type `rdsconfig.exe` to run the utility.
   
   For example:
   
   `C:\Program Files\RDS_5.0\IBM\Rational\RDS_5.0\RDSUtility\rdsconfig.exe`

3. The default URL for server authentication is displayed.

4. Type the following details as shown in the following example:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDS default URL is: ldap://localhost:1389/</td>
<td>Type <code>y</code> to use the default URL or if you type <code>n</code>, the program asks you to type the RDS url. Type the valid RDS url and press Enter.</td>
</tr>
<tr>
<td>Do you want to use the default url? [y/n]:</td>
<td>Note To open the RDS in secure mode, you can include the letter &quot;s&quot; in the ldap URL (where the &quot;s&quot; refers to the secure port), followed by a valid server name and a port number. For example: <code>ldaps://dirserv:1636</code>.</td>
</tr>
<tr>
<td>Enter the user name:</td>
<td><code>tdsadmin</code></td>
</tr>
</tbody>
</table>
Changing the RDS operation mode

Once you have entered all the details, the operation mode is changed and the message for successful mode change appears.

<table>
<thead>
<tr>
<th>Enter the password:</th>
<th>Type the <em>tdsadmin</em> password. It displays the current operation mode along with the list of operation modes to select from.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the operation mode to be set from the following:</td>
<td>Enter your choice: 2</td>
</tr>
<tr>
<td>0. Standalone mode</td>
<td>1. Corporate mode</td>
</tr>
<tr>
<td>2. OS authentication mode</td>
<td>3. Trusted OS Authentication</td>
</tr>
<tr>
<td>Do you want to proceed? [y/n]:</td>
<td>Type <em>y</em> to proceed</td>
</tr>
<tr>
<td>Enter the domain name:</td>
<td><em>example.com</em></td>
</tr>
</tbody>
</table>

Once you have entered all the details, the operation mode is changed and the message for successful mode change appears.

---

**Note** Whenever the operation mode is changed, the **Web server** needs to be restarted.

If the operation mode is changed from **Stand-Alone** to **Corporate**, the users must be migrated as corporate users.

5. Restart the RDS.
Trusted OS authentication settings

The RDS additionally supports specific settings for the IBM® Rational® System Architect®, and IBM® Rational® Synergy tools. The System Architect tool by default uses the Trusted Operating System (OS) authentication. The Trusted OS setting is enabled by default within RDS.

This configuration is designed to allow the IBM Rational System Architect and IBM Rational Synergy tool to use the existing OS authentication to log on to the RDS. The user is not prompted for user login dialog for tool connectivity to RDS.

Use the `rdsconfig` utility to enable or disable the Trusted OS authentication. For more details, see Changing the RDS operation mode section.

The image below shows an example of this setting.

![Image of rdsconfig utility output]

**Note** When the Trusted OS authentication is disabled, the RDS login dialog box appears.
Settings for assigning license feature

This section describes the settings that must be done for assigning the license features to users.

**Standalone mode**

The users must have their NT logon name or UNIX logon name configured in RDS to assign a license feature.

**Corporate mode**

The attribute `CORPORATE_LICENSE_FEATURE_LOGON_ATTRIBUTE` is configured in `TDSCOnfiguration.xml` file. By default, the value for this attribute is set to `samAccountName` for Active Directory Server corporate partition.

For other corporate partitions such as the IBM Tivoli Directory Server, the administrator must configure this value to a valid system login name (For example, uid).
Enabling Secure Sockets Layer (SSL) security

The following section describes the steps for enabling the SSL security. To enable the secure connectivity between the Rational tools such as IBM® Rational® DOORS®, IBM® Rational® System Architect® and the Active Directory Server, follow steps given in the following sections.

Exporting the certificate from the Active Directory server

To export the CA certificate from the Active Directory server, follow these steps:

1. Log on as a Domain Administrator to the Active Directory domain server that is being used to create the RDS partition.
2. Export the certificate from the Active Directory server to a file. To do so, follow these steps:
   a. Click Start>Control Panel> Administrative Tools>Certificate Authority to open the CA Microsoft® Management Console (MMC) GUI.
   b. Highlight the CA machine and right-click to select Properties for the CA.
   c. From General menu, click View Certificate.
   d. Select the Details view, and click the Copy to File button on the lower-right corner of the window.
   e. Use the Certificate Export Wizard to save the CA certificate in a file.

Note You can save the CA certificate in either DER Encoded Binary X-509 format or Based-64 Encoded X-509 format.

Importing the certificate to the IBM Rational products

You must import the certificate to each IBM Rational tools such as DOORS, System Architect etc.

To import the CA certificate to the IBM Rational products, follow these steps:

On Windows:

• Run the following command to import the certificate:

  <Telelogic tool Install path>/ibm/gsk7/bin/gsk7cmd.exe -cert -add -db <Telelogic tool Install path>/lib/certdb/tdsclientkey.kdb -pw tdskey4client -label ADS_LABEL -file <extracted Active Directory certificate.cer file>
Enabling Secure Sockets Layer (SSL) security

- The SSL setup is complete.

On Solaris:

- Run the following command to import the certificate:
  
  `/opt/ibm/gsk7/bin/gsk7cmd -cert -add -db tdsclientkey.kdb -pw tdskey4client -label ADS_LABEL -file <extracted Active Directory certificate.cer file>`

- The SSL setup is complete.

## Troubleshooting RDS

This chapter describes the possible problem and solutions for RDS users.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing or resetting the password with Non-ASCII characters does not work.</td>
<td>Changing or resetting the password with Non-ASCII characters are not supported by RDS.</td>
</tr>
<tr>
<td>Web RDA cannot be used for License Configuration on Solaris platform.</td>
<td>License Configuration on Web RDA does not function with RDA Web Access Server installed on Solaris. The RDA Web Access Server needs to be installed on Windows or Linux platforms to achieve the license configuration functionality.</td>
</tr>
<tr>
<td>Users cannot login after migration.</td>
<td>The RDS server needs to be restarted otherwise the data inconsistency is observed. For more information on starting the server, see Starting the directory server (page 11).</td>
</tr>
</tbody>
</table>
| When RDS in corporate mode is configured to DOORS, the users are displayed in RDA but not in DOORS. | If a custom attribute name is used in the corporate user DN, the custom DN attribute name should be added to the RDS schema. To add the custom DN: 1. Create the following script.  
```
    dn: cn=schema  
    changetype: modify  
    add: attributetypes  
    attributeTypes: (1.3.6.1.4.1.15265.0.100 NAME '<custom_attribute_name>' SYNTAX 1.3.6.1.4.1.1466.115.121.1.27 SINGLE-VALUE)  
```  
2. Save the script in a text file with the file extension as <filename>.ldif.  
3. Use the `ldapmodify` command to apply the schema change. |
Appendix: Notices

© Copyright 2000, 2010

U.S. Government Users Restricted Rights - Use, duplication, or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send written license inquiries to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some states do not allow disclaimer of express or implied warranties in certain transactions. Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

 Intellectual Property Dept. for Rational Software
 IBM Corporation
 1 Rogers Street
 Cambridge, Massachusetts 02142
 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product or service names may be trademarks or service marks of others.
Index

B
backing up the data 13

E
enabling SSL 20
enabling ssl 20
exporting certificate 20

I
IBM customer support 2
importing certificate 20
installation guide 8

L
license configuration on solaris 23
license feature settings 19

O
operation mode change 16
os authentication 15

P
PAM 15
password with non-ascii 23

R
RDS architecture 7
rdconfig utility 16
restore server 14
restoring the data 14

S
server backup 12
SSL 20
starting the directory server 11
starting the server 11
stopping the directory server 12

stopping the server 12

T
trusted os setting 18
trusted os settings 18

U
using PAM 15

W
Who should use this guide 8